Exporting
Animation

Flash MX 2004 isn’t just a vector graphics tool for the Web. Using

Flash, you can create amazing video effects for your home videos
or professional productions. This chapter explains how to use digital
video with Flash. It also shows you how to export high-quality mate-

rial from Flash to use in your video-editing applications.

As more developers learn how flexible and powerful the Flash MX
2004 authoring environment is, Flash graphics will be seen on screens
in every possible context. With a bit of tweaking, animations origi-
nally designed for the Web can be repurposed for stand-alone presen-
tations, broadcast, high-resolution digital projection, or even for
transfer to film.

In this chapter, we go over the main factors that need to be considered
when preparing Flash content for output to various linear formats.

High-Quality Video Output from Flash

Although Flash is primarily used to create interactive animations and
presentations on the Web, you can also generate high-quality output
for other media uses. Macromedia began as a company called
MacroMind, specializing in frame-by-frame video animation tools for
desktop computers. Their flagship product, VideoWorks, eventually
became Director, which was the first widely used Macromedia
authoring product. Like Director, Flash also has some “hidden” video
animation capabilities. You can use Flash to create spinning logos for
your own corporate, creative, or home videos. Or you can export
those shape morphs —so difficult to create elsewhere —to layer over
other video content. Flash can output the content of a FLA file as a
QuickTime multimedia file. Flash can also generate numbered still
sequences for use in other video-editing applications.

In previous Mac versions of Flash, 100 percent video-based (a.k.a.
raster-based) QuickTime (QT) files could be directly rendered via
the Export Movie command. Macromedia has added a more robust
solution —based on QuickTime 4 —that exports Flash material
directly to a Flash track for use in conjunction with video and audio
tracks from other sources. This is wonderful if you want to create
QTs for QuickTime 4-enabled applications.

/Note All references to QuickTime 4 can also be applied to QuickTime 5
~~  or 6—QuickTime 4 is just the earliest version that is integrated
with Flash.

CHAPTER

¢+ 0+ o+

In This Chapter

A history of digital
video

Preparing Flash
documents for video
output

Exporting audio from a
Flash document

Using Flash image

sequences in video
applications

¢+ s+



420

Part Ill + Creating Animation and Effects

Most Mac and Windows applications that use the QuickTime architecture — such as Adobe
Premiere and Adobe After Effects — will import QuickTime Flash movies. Some NLE (nonlin-
ear editing) software, such as Discreet Cinestream, will not allow you to import QuickTime
Flash movies. For the best video results, you will want to export still image sequences from
Flash instead of using QuickTime Flash files, or export traditional QuickTime Video files
(available only on the Macintosh version of Flash) or AVl files (available only on the Windows
version of Flash).

Because the export process for sequences uses generic vector or raster formats, you lose all

— interactivity that you have created in Flash. But that's perfectly fine because you're transfer-

ring your Flash movie to a linear viewing environment such as video —you're simply making
something to watch on a television or on a computer monitor without any interaction
required from the audience.

Flash artwork is completely scalable and flexible for just about any media use. Combined
with the QuickTime architecture, Flash artwork can be output to DV tape or motion picture
film. If you think your project looks good in Flash, you should be able to repurpose that hard
work into another format very easily.

A Quick Video Primer

If you're a neophyte to digital video, you need to know some basic terms and procedures
involved with digital video. The following section will be useful if you've never used digital
video or used it without really knowing what you were doing.

A brief history of digital video

In the past, viewing or editing digital video on a desktop computer was almost impossible. It
required expensive hardware such as super-fast processors, huge hard drives, video-capture
boards, and professional-quality video decks and cameras. Beginning at $15,000, such sys-
tems were out of reach for most users. But like most technology after it has been around for a
while, digital video equipment has become much more affordable for the average user.
Although digital video still requires fast and efficient computers to work well, it isn’t nearly as
expensive as it was in the past. You can get 200GB hard drives for under $200! Since the
advent of the DV (Digital Video) format (a.k.a. DVCAM or MiniDV), consumer-level video cam-
eras and decks are catching up to the quality of their professional-level counterparts.

The need for space

Why does digital video require so many resources? To begin with, digital video is entirely
raster-based. This means that, unlike Flash and other vector file formats, each frame of digital
video requires almost every pixel on the screen to be remembered and stored individually.
Vector formats, on the other hand, use mathematical descriptions of objects on the screen
and compute any differences or movement from frame to frame very efficiently. The resolu-
tion of an average television set is roughly equivalent to a 640x480 resolution at 24-bit color
depth on your computer monitor. Mathematically speaking, one frame of digital video at this
resolution is nearly 1MB!

640 x 480 x 3" = 921,600 bytes = 900 KB = 0.88MB

"Each byte has 8 bits. Therefore, 24 bits is equivalent to 3 bytes.
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If that isn’t bad enough, consider that 1 second of video contains 30 frames. That’s 26MB for
just 1 second of video! Only the fastest systems and hard drives on the market could deliver
such performance. One solution to this performance bottleneck was to compress the data.
Thus, most digital video now employs some form of compression (for storage) and decom-
pression (for playback). The short form of this expression is codec (compression and decom-
pression). You may have already heard of many codecs in use today, but what you probably
don’t know is that there are three kinds of codecs: software, hardware, and hybrid.

Cinepak, Indeo, RealVideo, and Sorenson are all software-based codecs, meaning that the

~  computer processor has to decompress each frame of compressed video. These differ from

hardware-based codecs, such as MJPEG (Motion JPEG, based on the Joint Photographic
Experts Group compression scheme), which need video-capture cards to compress and
decompress each frame of video.

The latest breed of codecs today is hybrids, both software and hardware based, such as the
MPEG (Moving Picture Experts Group) and DV codecs. MPEG currently has two versions,
MPEG-1 and MPEG-2. Originally, MPEG-1 and MPEG-2 video needed special hardware to
playback, but as computer processors got faster, software-based players could handle the
decompression tasks. Today, MPEG-2 is standard for DVD.

DVD, or digital versatile/video disc, is a new storage medium that can handle feature-length
movies in a snap. DVD should not be confused with DV, which refers to true Digital Video, in
which the source video originates as binary (zeros and ones) data. Furthermore, the general
term digital video should not be confused with DV. Digital video usually refers to the any
video that has been stored as binary data, although it most likely originated from an analog
source such as a regular VHS or BetaCam video camera. DV refers to video that originated
from a digital (a.k.a. binary) source and that remains digital through any number of edits on a
digital system. With the current implementation of DV, using IEEE-1394 (a.k.a. FireWire or
i.LINK) technology, video is transferred from digital tape to your computer hard drive with no
loss of quality. The DV footage is not recompressed unless the image in the footage is
changed during editing by adding effects or transitions. But like any digital video, DV still
requires a lot of hard drive space —about 2GB for every 9 minutes.

Older operating systems have a maximum file-size limit of 2GB. This means that you cannot

- have more than 9 minutes of DV-compressed footage in one QuickTime or AVI file. However,

you can string many movies together during playback for continuous recording. New ver-
sions of the Mac OS (version 9.0.4 or higher) and of the Windows OS support files that are
larger than 2GB. Even so, some applications may not be capable of using these larger files
unless they've been updated to do so.

Codec, frame size, and frame rate: The keys to manageable video

Before you begin any digital video project you should have a clear understanding of codecs.
Most software-based codecs are intended for computer playback and distribution, while
hardware-based codecs are intended for capturing and editing original footage to be used for
television broadcast or feature films. You can repurpose hardware-based codec video by com-
pressing it with a software-based codec. Most video developers take high-quality video and
shrink it, in both frame and file size, to fit onto multimedia CD-ROMs or the Web.

Three variables can be applied to digital video to make it more manageable for most con-
sumer computer systems: frame size, frame rate, and compression. Developers often use all
three variables to shrink huge 9GB video projects down to 3-5MB, which may lead to undesir-
able results.
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First, let’s talk about frame size. Although most professional video uses a 640 x 480 or greater
frame size, you may have noticed that most video on multimedia CD-ROMs only takes up a
quarter or less of your entire computer monitor. Most video on the Web or CD-ROMs is ren-
dered at 320 x 240 resolution, half the resolution of broadcast video. Actually, this is only
slightly less than the horizontal-line resolution of your VHS recordings.

What about frame rate? You may have also noticed that video on multimedia CD-ROMs often
looks a little jerky or choppy. Although this may be due to a slow processor, it’s more likely
that —in order to cut the file size —the frame rate of the video was reduced. It’s not uncom-
mon to find CD-ROM frame rates as low as 12 or 15 fps (frames per second) —about half of
the original frame rate of broadcast video. This slower frame rate is also the default frame
rate of a new Flash movie, to ensure consistent playback on slower machines. Despite the
drop in video quality, the lower frame rates result in much smaller file sizes with fewer frames
for the processor to play within each second, which delivers better CD-ROM performance.

Finally, how does compression affect video? You've probably noticed that Web and multime-
dia CD-ROM video is often blocky looking. This is due to the software-based compression that
has been used on the video. Codecs look for areas of the frame that stay consistent over
many frames, and then log those areas and drop them from subsequent frames. The result is
that no unnecessary repetition of data exists that needs to be continually decompressed. But,
depending on the level of compression used, the properties of the codec itself, and the set-
tings used in running that codec, the video varies in quality.

Keeping with the trend of better and faster, digital video continues to improve dramatically.
This is well illustrated by the fact that many popular Web sites, such as Apple’s QuickTime
Web site (www.apple.com/quicktime), now enable visitors to download larger, higher-
quality videos (upwards of 15MB) for playback on newer, faster systems.

Playback bottlenecks

Digital video needs to be kept small for two reasons: storage and playback. So far, we have
largely discussed storage issues. But playback (or transfer rate) further complicates the
creation of digital video. Despite the relatively large capacity of CD-ROMs (650MB), most
CD-ROM readers have limited transfer rates of about 600 KB/second. It’s important to note
that each second of video cannot exceed the transfer rate; otherwise the video will drop
frames to keep up with the audio. So if the video is distributed via CD-ROM, this factor results
in serious limitations.

Let’s look at some of the math involved under ideal (choppy) playback conditions: If you

use 15 fps for compressed video, you are limited to a maximum of roughly 40 KB per frame.
(Remember, however, that the playback stream usually includes an audio track as well, which
means that less than 40 KB is available for the video component of each individual frame.)

For more information on audio formatting and compression, see Chapter 15, “Adding Sound.”

Unfortunately, the Web still affords less than ideal playback conditions for video. On the Web,
transfer rates can be as slow as 500 bytes/second. On average, a 56 KB modem downloads
around 4 KB/second. The ideal Web video should stream to the user while loading the page. If
you intend to stream video quickly, you have to keep this very small transfer rate in mind.
Large videos simply will not stream! This is why most Web sites offer larger videos as a down-
load file. But you do have an alternative. Later in this section, you can learn how to extract a
minimal number of frames in order to simulate digital video motion with Flash, yet keep your
Flash files streaming quickly. As modem technologies get faster, however, we’ll most likely see
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bigger and better video delivered across the Web. The ADSL (Asymmetrical Digital Subscriber
Line) modem was developed with the MPEG-1 and -2 standards in mind.

Adjusting Flash Movies for Video Output

By default, Flash MX 2004 uses a frame rate of 12 fps for all new movies. Unless you have
changed this setting with the Modify &> Document command (Ctrl+J or 8+J), this is the setting
for any Flash document you have created so far. As mentioned earlier in this chapter, broad-
cast (NTSC) video needs 30 fps (29.97 fps to be exact) for motion to be smooth and fluid. It
may be necessary for you to add more blank frames between each of your tweened
keyframes to accommodate a faster frame rate. Your 5-second intro to your Web site may
have been possible with 70 or fewer frames, but now you need 300 frames for the same
amount of time in full-motion video. Flash doesn’t support interlacing (or field-ordering) with
any export method (see the “What Is Interlacing?” sidebar for an explanation of interlacing).
As aresult, you need twice the number of frames (double the frame rate) used for every sec-
ond of NTSC video —59.94 fps to be exact —to properly render full-motion video from Flash.
It’s easier to use 60 fps in Flash and then alter the rendered sequence to 59.94 fps in the
video-editing application.

However, 60 fps may be an unrealistic frame rate to time your animation. Several hundreds (if
not thousands) of frames are necessary for this frame rate. As you will see later in this chap-
ter, you can achieve high-quality video using 30 fps for your Flash documents. If you have the
flexibility and skill to animate at 60 fps, you may want to do so.

Caution If you are using the PAL or SECAM video systems, which are video systems used outside of
North America, then you need to use different frame sizes and frame rates to accurately ren-
der Flash content. Use the same methods described here, but adjust any values to fit within
PAL or SECAM specifications.

If possible, restrict your Flash movie to one scene for video-editing purposes. Flash exports
all scenes within a Flash movie into a sequence or QT/AVI movie, which may complicate the
editing process later. It’s easier to make more Flash movies and render them independently of
each other.

Frames stored in Movie Clips do not export with sequences. Make sure that you have either
removed any Movie Clip symbols or that you have replaced them with the actual frames con-
tained within the Movie Clip.

To replace a Movie Clip symbol with the actual frames contained within it:
1. Open the Movie Clip in the Library, and select the frames in the Timeline window.

2. Copy the frames with the Copy Frames command (Ctrl+Alt+C or 38+Option+C) in the
Edit menu.

3. Go back to the scene and paste the frames with the Paste Frames command (Ctrl+Alt+V
or 88+Option+V). Paste the frames on their own layer, so that they won’t conflict with
any tweens or settings in other layers.

Caution Remember that, unlike regular Flash movies, the exported sequence will not have any inter-
activity. The sequence is simply a collection of still images that will be compiled later in your
video-editing application. (So don’t mistakenly overwrite or delete your original Flash
document!)
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What Is Interlacing?

Most computer monitors are non-interlaced, which means that each “frame” of video is fully dis-
played with each screen refresh. Most TV sets, however, are interlaced displays, which means
that each frame of video consists of two fields: one upper and one lower, and each screen
refresh shows one field and then the other. Therefore, each second of video contains 60 fields, or
30 frames. Because Flash doesn't export field-ordered sequences, you have to compensate for
the lack of individual fields by using two Flash frames for every regular frame of video.

You may also need to adjust your Flash document’s pixel width and height. Depending on the
type of video-editing software and hardware you are using, this setting needs to be 640 x 480,
640 x 486, 720 x 534 (DV), 720 x 540 (D1), or something else. Again, use the

Modify => Document command to adjust the size of your Flash document. You may notice that
adjusting pixel sizes of the Flash document doesn’t have the same effect as changing pixel
heights or widths of raster-based images. Usually, adjusting pixel sizes will distort or change
the shape of elements. With Flash, the document’s pixel size is independent of the pixel sizes
of any elements it may contain. You're simply adding or subtracting space to the area of the
Stage. If you intend to bring the sequence into another video-editing application such as
Adobe Premiere and you are outputting with the DV format, a movie size of 720 x 534 should
be used. Why? The DV format uses nonsquare pixels delivering the same 4:3 aspect ratio with
720 x 480 as other video formats do with only 640 x 480 square pixels. By using 720 x 534
movie sizes, the frame can be stretched to fit a 720 x 480 DV workspace without losing any
resolution quality. It’s better to adjust the size before you export any material intended for
broadcast video delivery (or for transfer to any NTSC recording media), especially with raster
formats. Not only does this ensure optimal quality; it could easily lessen the video rendering
time needed in other applications.

/\Iote The movie sizes just listed should work equally well for MJPEG video hardware and DV hard-

On
(W)

ware. If you use these baseline settings, you can accommodate either MJPEG or DV specifi-
cations in your video-editing application.

Not only do you need to have the proper frame size for high-quality video output, but you also
need to be aware of overscanning. TV sets overscan video images, which means that informa-
tion near the edges of the frame may be cropped and not visible. Because the amount of over-
scan is inconsistent from TV to TV, some general guidelines have been developed to make sure
vital information in the frame is not lost. The crux of the guidelines is simple: Don’t put any-
thing important (such as text) near the edges of the frame. Video has two safe zones: title-safe
and action-safe. To see these zones in a sample document in Flash, refer to Figure 14-1.

folder of this book’s CD-ROM.

the & You can find the document shown in Figure 14-1, Video SAFE Exp DV.fla,inthe chl4

\ W

The action-safe zone is approximately 90 percent of the 720 x 534 (or 640 x 480) frame size
we're using in Flash, which calculates into 648 x 480 (or 576 x 432). All of your Flash artwork
should be contained within the limits of the action-safe zone. The title-safe zone is about 80
percent of the total frame size. For a 720 x 534 frame size, any text on the Flash stage should
fall within the borders of a 576 x 427 centered frame. With a 640 x 480 frame size, this cen-
tered frame size would be 512 x 384.
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Figure 14-1: While designing for broadcast content in Flash MX 2004,
you should always be aware of the safe-zone boundaries for NTSC
video playback.

Finally, you may need to adjust the colors and artwork you used in your Flash document.
NTSC video, while technically 24-bit, doesn’t display some colors very well. In general, bright
and saturated RGB colors tend to bleed on regular TV sets. Here are some guidelines for
using broadcast (and WebTV)-safe color:

4 Avoid one-pixel-wide horizontal lines. Because NTSC is interlaced, this line flickers con-
stantly. If you need to use thin lines, try blurring a one-pixel line or simply never use
anything less than a two-pixel stroke width.

Tip You can convert a one-pixel or hairline stroke to a fill by choosing Modify <> Shape => Convert
. Lines to Fills. Use Modify => Shape => Soften Fill Edges on the converted line to blur it.
5
4+ Do not use very fine textures as they may flicker and bleed at the edges. Because most
NTSC monitors have low-quality resolutions, the fine details are lost anyway:.

4 Avoid using any color that uses a color channel’s maximum intensity. Use an NTSC
color filter on any bitmap art, such as the NTSC Colors filter in Adobe Photoshop:

e Full red (R: 255, G: 000, B: 000) displays horribly on TV sets. Replace a full red
with R: 181, G: 000, B: 000.
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Tip

e Pure white backgrounds should also be avoided and replaced with R: 235, G: 235,
B: 235. Like red, pure white can cause annoying screen flicker, especially if high
contrast objects are placed against the white.

e As arule of thumb, keep your RGB values within the 16 to 235 range, instead of 0
to 255. Although Photoshop’s NTSC Colors filter actually allows certain 255 val-
ues to be used, you should only use these values if they do not occupy large solid
areas in the Flash movie.

4 Use the NTSC & Web Safe color set (ntsc_web_179.act file) on the Macromedia Flash
MX 2004 Bible CD-ROM (see Chapter 7, “Applying Color,” for more information on
importing or switching color sets). Of the 216 Web-Safe color palettes, only 179 of them
are NTSC/WebTV safe. NTSC TV sets are capable of displaying more colors than that,
but if you're used to working with Web color palettes, then you may find this optimized
palette handy. There’s another color set file, ntsc_213_colors.act, on the CD-ROM
that you can use if you're just taking Flash content to video, which has 213 NTSC-safe
colors, converted from the 216 Web-Safe colors. Because 35 colors in this set are outside
of the Web-Safe colors, you should not use this palette for Web and broadcast work.

4+ If you're using video-editing software that allows both color and levels corrections on
imported clips, then you can avoid making time-consuming adjustments to your origi-
nal Flash movie. After you’ve generated a Flash sequence and imported the sequence
into your video-editing application, restrict the gamut of the sequence clip using the
values in the preceding tips.

In After Effects, use the Broadcast Colors filter to perform NTSC color adjustments on

), imported sequences or movies. This filter can adjust either luminance or saturation values to

o

bring out-of-gamut colors into the NTSC color gamut. Use caution, however, as reducing the
luminance may cause artifacts from MJPEG or DV compression to become more obvious.
Reducing saturation is the preferred method for using the Broadcast Colors.

Refer to Table 14-1 to see how Photoshop’s NTSC Colors filter remaps the saturated values of
the Web-Safe color palette.

Table 14-1: NTSC Color Conversion Chart

Original Web Original RGB Converted RGB
HEX Value Web Value NTSC Value
R G B R G B
FFO033 255 000 051 227 000 045
CC6699 204 051 153 204 102 153
FFOOFF 255 000 255 210 000 210
R G B R G B

FFOOCC 255 000 204 219 000 175
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Original Web Original RGB Converted RGB

HEX Value Web Value NTSC Value

FFO099 255 000 153 226 000 136
FFO066 255 000 102 230 000 092
CCOOFF 204 000 255 199 000 248
00CCCC 000 204 204 000 170 170
OOFFFF 000 255 255 000 170 170
33FFFF 051 255 255 045 225 225
66FFFF 102 255 255 101 253 253
00CCFF 000 204 255 000 160 201
0099FF 000 153 255 000 147 245
00FFCC 000 255 204 000 178 143
33FFCC 051 255 204 047 237 190
00FF99 000 255 153 000 188 113
33FF99 051 255 153 050 249 150
00CC66 000 204 102 000 193 096
O0OFF00 000 255 000 000 210 000
OOFF33 000 255 051 000 210 042
O0O0FF66 000 255 102 000 198 079
33FF00 051 255 000 047 234 000
66FFO0 102 255 000 088 220 000
99FF00 153 255 000 122 203 000
99CC00 153 204 000 142 190 000
FFFF66 255 255 102 252 252 101
CCccoo 204 204 000 170 170 000
CCFFOO 204 255 000 148 185 000
FFCCO0 255 204 000 191 153 000
CC9900 204 153 000 197 148 000
FF9900 255 153 000 216 130 000
FF6600 255 102 000 248 099 000
FFO000 255 000 000 181 000 000
CC0000 204 000 000 181 000 000
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Creating Sequences from Flash Movies

A sequence is a series of still images that simulate full-motion video when played back contin-
uously. Think of a sequence as a regular QuickTime or AVI broken down into individual
frames. Another analogy would be that of a flipbook made of individual sketches that animate
when you thumb through the pages quickly. Flash MX 2004 can export a scene or movie as a
series of still images as well, with quite a bit of flexibility.

Because Flash artwork is vector-based, it supports all the major vector formats used in other
applications: EPS 3.0 (or higher), lllustrator, and DXF formats. On the Windows version of
Flash, you can also export metafile sequences in the WMF and EMF formats. Generally, all of
these vector formats will retain the scalable quality that Flash offers for the Web; that is, you
can shrink or expand the size of vector formats, displaying equal smoothness and quality at
all sizes. Most vector formats can also embed raster content, and any raster content will have
a finite resolution capacity. You will notice degradation on any embedded raster elements if
you scale the entire vector graphic beyond its original fixed pixel size.

You can also export a still sequence in raster-based formats such as PICT (Mac only), BMP
(Windows only), GIF, JPEG, or PNG. We can review the benefits of each format and the partic-
ular uses each can have, but first, we should look at how the exporting of individual frames is
accomplished in Flash.

Export process in Flash

After you have opened a Flash document that you wish to export, make sure that your docu-
ment falls within the guidelines described in the last section. All of these settings are critical
for flawless video playback: 30 or 60 frames per second, 640 x 480 (or greater) movie dimen-
sions, integration of scenes and Movie Clips, and color gamut restrictions. When you’re all
ready to go, the actual export process is quite simple. You will export your Flash document as
a series of still images that can later be compiled by a video application.

Hi‘}\ You can use the characterAnim. f1a document from the ch14 folder of the Macromedia

Flash MX 2004 Bible CD-ROM. Sandro Corsaro (www.sandrocorsaro.com) provided this

\-& | excellent sample of his Flash animation.
' /
s

1. Open your Flash document and select File = Export > Export Movie.

2. Browse to (or create) the folder where you want to store the sequence. Choose an
empty folder —you don’t want to have several files from the sequence mixed with
other files. See Figure 14-2.

3. In the Format menu (Mac) or Save as type menu (Windows), choose the type of file you
want Flash to create. If you're using the sample Flash document on the book’s CD-ROM,
use the PICT format if you're using the Macintosh version of Flash MX 2004 (see Figure
14-3 for specific settings). Use the BMP format if you're using the Windows version (see
Figure 14-4 for specific settings). Later, you can use the exported PICT or BMP
sequence in the Adobe After Effects section.
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Figure 14-2: The Export Movie
dialog box in the Mac
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Figure 14-3: The Export PICT dialog box on the Mac

Export Bitmap Eigure va'-4<; The Export Bitmap dialog
ox on Windows

“fidth Height
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Cancel
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4. Specify a filename and click Save. Flash MX 2004 will automatically append a series
of numbers to the end of the filenames, such as anim_0001, anim_0002, and so on.
Flash generates a still image for each frame in the Flash timeline. This process can
be quite lengthy if you have several hundreds of frames in the timeline. When you
browse the directory where the files were saved, you should see a listing similar to

that of Figure 14-5.
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Figure 14-5: When you export a Flash movie as a
sequence, Flash generates a still image (that is, one file)
for each frame in the Flash movie.

For the highest quality video rendering, use a vector file format for export. The next section
details each file type and its particular uses. However, if you export a raster image at the full

»

N

<} size of the video frame (such as 720 x 540), you will not experience any resolution loss as

long as you don't scale the exported artwork in the video application.

If you want to jump right into After Effects to output this footage to DV video, then proceed to
the “Importing Image Sequences into After Effects” section at the end of this chapter. If you
need to export an accompanying Stream sound (or series of sounds in a soundtrack on the
Main Timeline), jump to the section of this chapter titled “Exporting Audio from Flash
Documents.”

Uses of each sequence format

Flash can export in a variety of file formats, and each one has a particular purpose. While vec-
tor formats allow the most scalability, some Flash artwork does not display properly when
converted from vector to raster. Raster formats usually maintain the highest fidelity to origi-
nal Flash artwork, but the file sizes can be rather large.

Vector sequence formats

Use a vector format type for your sequences when you want the highest quality image trans-
lation in applications such as Adobe After Effects or Premiere (see Table 14-2 for a list of for-
mats that can be exported from Flash). Flash exports vector sequences very quickly, but
these files may take longer to re-render in your video-editing application than raster formats.
Once you see the smooth edges of vector-rendered sequences, however, you can see that it is
worth the extra time. Vector formats automatically matte out the Flash background color,
making it quick and easy to superimpose Flash graphics with other content.
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Caution You may want to test a single EPS or Al file export (using File => Export Image) from Flash MX
2004 in your target video application. The EPS format natively uses CMYK (Cyan, Magenta,
Yellow and blacK) color space. Flash artwork uses RGB (Red, Green and Blue) color space. If
the RGB colors are converted to the CMYK color space during the export, you may notice
extreme color shifts with your Flash artwork when you view it in your video application.

Table 14-2: Flash-Compatible Vector Sequence Formats

Export Format Extension Description
EPS (6.0 or earlier); .eps Universal vector format recognized by most editing or
Encapsulated PostScript design applications. This is the preferred format for

high-quality vector export. However, any gradients
created in Flash will not export well with this format.

Illustrator; Adobe ai Proprietary file format mainly used by Adobe

lllustrator applications. Any gradients created in Flash will not
export well with this format.

DXF; Drawing .dxf AutoCAD 2D/3D file format. Because this format does

eXchange Format not support fills, it is mainly used for drafting plans or

schematic drawings. This format is used by most CAD,
3D, and modeling programs for transferring drawings to
other programs.

WMF/EMF; Windows wmf, .emf There's no reason to use these formats over the other
Meta File/Enhanced vector formats. While some non-Microsoft applications
Meta File support them, they aren’t widely used on either Mac or
PC systems.
Caution Mask layers (and the artwork that they mask) will not export properly in EPS sequences. The

artwork in the Mask layer will show up in the exported EPS file(s). If you use Mask layers in
your Flash document, export raster image sequences instead of vector.

Raster formats

All raster formats can export at variable pixel widths, heights, and resolutions. As long as your
Flash document (.fla file) is in the proper aspect ratio for video (usually 4:3), you can scale up
your Flash movie on export (see Table 14-3 for a list of raster formats that Flash supports).
This will save time during the rerendering process in the video-editing application. Not all
raster file formats support alpha channels, which are necessary if you intend to superimpose
exported Flash graphics on top of other video content.

Refer to Chapter 35, “Working with Raster Graphics,” for more detailed information on the
options associated with each raster file format.

Reference



437  Partlll 4+ Creating Animation and Effects

Table 14-3: Flash-Compatible Raster Sequence Formats

Flash Export Format File Extension Description
PICT (Mac only); .pct (or .pict) Can be used with many PC and all Mac programs.
Picture Variable bit-depths and compression settings with

support for alpha channels. Allows for lossless
compression.

BMP (PC only); .bmp Can be used with all PC and some Mac programs.

Windows Bitmap Variable bit-depths and compression settings with
support for alpha channels. Allows for lossless
compression.

GIF; Graphics gif Limited to a 256-color palette. Not recommended for

Interchange File full-motion NTSC video.

JPEG; Joint .jpg (or .jpeg) Only supports 24-bit RGB color. No alpha channel

Photographic Experts support. Recommended for full-motion NTSC video,

Group but this format does throw out color information due
to its lossy compression method.

PNG; Portable .png Supports variable bit-depth and compression settings

Network Graphic with alpha channels. Lossless compression schemes
make it ideal for projects intended for NTSC video
output.

Creating AVI Files on Windows

If you want a quick-and-dirty 100-percent raster-based video version of your Flash document,
and you use the Windows version of Flash MX 2004, you can export your Flash document as a
Video for Windows movie (.avi file). If you want the best video quality for output to video-
tape, you shouldn’t use this method for rendering video. Flash doesn’t support interlaced
video and won'’t create the smoothest possible video content directly. This export file format
is used primarily for digital video intended for computer playback, not NTSC playback.

You can render a Flash movie at twice the frame rate of NTSC video (29.97x2 = 59.94 fps)

- using the necessary codec for your video hardware. If you want to play the AVI through your
IEEE-1394 (a.k.a. FireWire, i.Link) hardware, you need to resize the 720 x 534 AVI movie to
720 x 480 in a video-editing application or by using the Dimensions property of the Export
AVI Settings dialog box. Do not change the properties of the original Flash document (.fla
file) via Modify <> Document! DV uses non-square pixels, and shapes will be stretched if you
use a 720 x 480 movie size in Flash.

Choose Export Movie from the File menu. Select a folder (or create one) to store the AVI file,
type the filename, and click Save. You will then see the Export Windows AVI dialog box with
the following options (see Figure 14-6).
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Figure 14-6: Adjust the values of the
Windows AVI settings to accommodate y
our playback needs.

This property enables you to scale your AVI movie. If you wish to scale the movie’s width sep-
arate from the height, clear the Maintain Aspect Ratio check box for this property. This may
be necessary if you have to accommodate non-square pixel formats such as DV or D1.

Video format

The drop-down menu associated with this property enables you to choose a bit-depth for the
AVI movie. For serious video work, you’ll want to choose 24-bit color or greater.

4 8-bit color: Limits the rendered movie to 256 colors that are determined on the fly by

Flash.

4 16-bit color: Limits the movie to 65,536 colors; also known as High Color in Windows or
Thousands of Colors on the Mac.

4 24-bit color: Enables the movie to use full RGB color (16.7 million colors); also known
as True Color on the PC or Millions of Colors on the Mac.

4 32-bit color w/ alpha: Enables the movie to use full RGB color and store an alpha chan-
nel for compositing effects. Not all video codecs can store alpha channel information.

4+ Compress video: If this option is checked, you are given the option to select a video
compressor (codec) after you click OK on the Export Windows AVI dialog box. If you
don’t select this check box, Flash generates uncompressed video frames, which can
take over 1MB of file space per frame. In general, you don’t want to use uncompressed
video; it takes a lot more time to rerender uncompressed video into the hardware
codec used by your video setup.

Caution

Even if you want to use uncompressed video, we recommend that you select the Compress

video option and choose None for the compressor.

4 Smooth: Using the smooth option anti-aliases the Flash graphics. This adds more time
to the export process, but your AVI file looks much more polished. If you just want
faster exporting, and you need only a rough AVI movie, clear the Smooth check box.

Sound format

This drop-down list enables you to specify the audio sampling settings. If you didn’t use any
audio in your Flash movie, choose Disable. For a description of each of the sampling rates
and bit-depths, refer to Appendix B, “Digital Audio Basics.”
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Video compression

When you've chosen the options you need, click OK. If you specified Compress Video, you'll
see the dialog box shown in Figure 14-7:

Video Compression Figure 14-7: Choose the proper video codec for your
R— 1| video output hardware, or select a software-based codec
Ful Frames [Uncompressed] | v for computer playback and distribution.

In the Video Compression dialog box, you can select a software- or hardware-based codec to
use for the AVI movie. By default, Flash chooses Full Frames (Uncompressed). This option is
the same as deselecting Compress Video, which forces Flash to render full-frame video.
Because you probably want manageable file sizes, choose the codec that will be compatible
with your video hardware. If you want to simply review your Flash work as an AVI movie, use
Cinepak or Indeo codecs. Adjust the codec settings as necessary for your needs. Smaller files
and lower quality will result from using compression qualities less than 100 percent, export-
ing selective keyframes, and limiting data rates. For high-quality rendering using hardware-
based codecs, make sure that the hardware codec (such as MJPEG or DV) is set to 100
percent compression quality with no keyframes or data-rate limiting. When you have chosen
all the appropriate settings, click OK.

Flash then exports an AVI movie file to the folder you specified. Depending on the length of
your Flash movie and the video codec used, the export process could take less than a minute
or many hours. Unfortunately, Flash doesn’t give you an estimated time for completion as
Adobe Premiere or After Effects does. When Flash has finished exporting the file, you can view
the video with Windows Media Player or with the software that your video hardware uses.

Exporting Audio from a Flash Document

If you created a Flash animation with Stream sounds that are synchronized to the animation
of the artwork, you may want to export the audio as a separate file to combine with exported
image sequences in a video application such as Adobe After Effects. If you created QuickTime
Video or Windows AVl files, then you can export audio directly in the export options of these
file formats. This section describes how to export audio separately from the animation within
a Flash document.

On the\?'-’-;\\ Open the characterAnim. f1a document from the ch14 folder of the Macromedia Flash
‘ CD-RBM "\  y1x 2004 Bible CD-ROM. You can export the audio track of this document to use with the
\\.& / matching image sequence that was exported earlier in this chapter.

e

1. Open the Flash document. Make sure any and all sounds that you want to include in the
exported audio file are located on the Main Timeline (that is, Scene 1). Each sound on a
keyframe should be set to the Stream sync option in the Property inspector.
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2. Choose File = Export = Export Movie. On Windows, choose WAV audio in the Save as
file type menu, and specify soundtrack.wav as the filename. See Figure 14-8 for the WAV
settings that follow the Export Movie dialog box. On the Mac, choose QuickTime Video
in the Format menu, and specify soundtrack.mov as the filename. With the Mac version
of Flash MX 2004, you cannot export a sound file—you can, however, export a
QuickTime Video and simply disregard the video track when you import the .mov file
into your video-editing application. See Figure 14-9 for the QuickTime Video settings
that follow the Export Movie dialog box.

Export Windows WAV Figure 14-8: The Export Windows WAV
dialog box
Sound Fomat: | 44kHz 16 Bit Sterea i
[“] lgnare event sounds | Cancel
Help ‘
Export QuickTime Video
Width Height ok
Dimensions: 10 x 10 pixels
rar—
i = Cancel
[ Maintain aspect ratio —
Format: = 16 bit color ?
[JJsmooth
Compressor:  Animation ﬂ
Quality: N
i i
Y —r T —
Sound Format. = 44kHz 16 Bit Stereo ﬂ Help

Figure 14-9: The Export QuickTime Video dialog box

Caution Though you can export Event sounds with the WAV file format on the Windows version of
Flash MX 2004, we recommend that you only use Stream sounds for exact synchronization
of sound and image in your Flash animations.

Once you have exported the sound from the Flash document, you’re ready to combine the
exported image sequence with the sound file. In the next section, you learn how to combine
these sources in Adobe After Effects 6.

Importing Image Sequences into After Effects

Now that you've created an image sequence (and supporting audio track, if necessary) with
Flash MX 2004’s Export Movie command, you can bring the newly generated material into
most video-editing applications. Not all video-editing applications will accept still image
sequences and will automatically treat them as one video clip (as Adobe After Effects and
Premiere do). In this section, you see how to prepare an image sequence for video output.

Adobe After Effects is the video production equivalent of Photoshop. After Effects allows you
to modify moving images in ways similar to how you modify still images in Adobe Photoshop.
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With powerful native tools and filters, as well as a vast array of custom effects plug-ins, After
Effects is a program with enough depth to keep many motion graphics designers happy for
years. Although After Effects is a complex program with innumerable settings, you can cer-
tainly use it for simple tasks as well.

At the time of this writing, Adobe After Effects 6 was the latest version of the product. You
i can download a trial version of this software at www.adobe.com/support/down-
loads/main.html.

Using After Effects, you can achieve the highest quality video from your Flash-generated
image sequence. That’s because After Effects offers subtle controls for video clip and compo-
sition settings that deliver crisp, interlaced, frame-accurate video.

After Effects can continuously rasterize any vector content, meaning that After Effects can re-
render each vector frame into a raster frame. Most video applications, such as Adobe
Premiere, rasterize the first frame of a vector image and continue to reuse that first rasterized
version for the entire render process.

What does that mean? Simply put, if you have a small vector circle in the first frame of a pro-
ject that grows larger in subsequent frames, then the circle appears very jagged at the larger
sizes. Although both Premiere and After Effects render a Flash-generated image sequence at
the same quality, please note that if you want to do special effects with just one frame (or still)
from a Flash movie (not an entire image sequence), then After Effects does a much better job.
Also note that this can be confusing because there are two potential uses of material imported
from Flash into either After Effects or Premiere. These are either single-frame imports or multi-
frame imports. The general point is this: After Effects does a consistently high-quality job with
both types, whereas Premiere handles only the latter type (multiframe) well.

Caution While EPS and Al image sequences offer the most scalability for digital video production,

Flash poorly translates gradients in these formats into common PostScript-defined colors. As
a result, gradients appear as solid color fills in After Effects. If you're using gradients in your
Flash artwork, it's best to export the movie as a raster sequence. After Effects can import a
PNG, BMP, or PICT sequence, which has less degrading compression than JPEG.

The following steps show you how to import a sequence into After Effects 6. If you exported
an image sequence from the exercise earlier in this chapter, then use that sequence for this
exercise.

1. Open an existing After Effects project (.aep file) or create a new project (Ctrl+Alt+N or
8+Option+N).

2. Double-click in the Project window to import the image sequence. In the Import File
dialog box, browse to the folder containing the image sequence. Select the first file of
the sequence (for example, anim_0001) and select the appropriate Sequence check
box (such as PICT Sequence, JPEG Sequence, EPS Sequence, and so forth), as shown in
Figure 14-10. Click Import.

3. If After Effects detects an alpha channel in the imported file(s), then an Interpret
Footage dialog box opens, as shown in Figure 14-11. You must tell After Effects how to
treat the alpha channel. For any image (or image sequence) with an alpha channel
imported from Flash, use the Straight — Unmatted setting.
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Import File
Show: All Acceptable Files ﬂ
From: | sequence ﬂ
anim_0001 O
anim_0002
anim_0003
anim_0004 | @
anim_0041
anim_0005
anim_0006 .
anim_0007 v
-
e
Format:  PICT Find
Import As: ~ Footage ? Find Again
@PICT Sequence
[ Force alphabetical order
mpart Folder
Go to:
f ; N 7 =TT
Add to Favorites Cancel F Impmq

Figure 14-10: The Import File dialog box

Interpret Footage

“3nim_[0001-0145] *has an unlsbe kd apha channel.

Alpha

T Ignore
@ Straight - Unmatted
O Premultiplied - Matted With Color: ([
P r—erm—
Guess

! Invert Alpha

You ¢an set a pre ference to skip this diabg.  Tancel

N o)

Figure 14-11: After Effects automatically detects the presence of

an alpha channel in imported file(s). For alpha
Flash creates, use the Straight — Unmatted setti

. Select the imported sequence (now shown as

channels that
ng.

one footage item) in the Project window

and choose File = Interpret Footage => Main. This time, the Interpret Footage dialog box
(see Figure 14-12) displays the complete settings for the selected footage file. In the
Frame Rate section, enter the correct frame rate in the Assume this frame rate field. If
you followed the guidelines given earlier in this chapter, then you used a 30 or 60 fps
for your Flash document. Enter that value here. Also, make sure Square Pixels is
selected for the Pixel Aspect Ratio setting. If you are using the image sequence from the

earlier exercise, use a frame rate of 30 fps.
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Interpret Footage

Interpretation for "anim_[DDD1-0145]"
Alpha

" lgnore [~ Inwert Alpha
+ Straight - Unmatted

 Premultiplied - Matted With Calor: I

Guess
Frame Rate
~
(* Assume this frame rate: 30] Frames per Second
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Separate Fields: | Off -

-
Guess 3:2 Pulldown ‘ Guess 24Pa Pulldown
Other Cptions
Pixel Aspect Ratio: | Square Pixels ]
Loop: |1 Tirnes
Ok cancel |

Figure 14-12: In the complete Interpret Footage dialog box,
you can set the frame rate and pixel aspect ratio for the Flash
image sequence. This figure shows the Windows version

of this dialog box.

. Import any supporting audio file for the image sequence. For our sample image

sequence, you can import the soundtrack.wav or soundtrack.mov file you created in an
earlier section. You should use the Interpret Footage command on this file as well —
make sure it has the same frame rate as the image sequence.

. Create a new composition via the Composition &> New Composition command (Ctrl+N

or 88+N). Name the composition Flash Animation. Depending on your video hardware,
the settings for a new composition will vary. For the Duration section, enter a value
greater than or equal to the length of the imported Flash sequence. See Figure 14-13 for
a DV-specific composition. For the sample image sequence, use a duration of 4 seconds
and 25 frames (0;00;04;25), as shown in Figure 14-13.

. Drag the Flash sequence footage file (such as anim_[0001-0145]) from the Project win-

dow to the Timeline window for the Flash Animation composition. The footage will
automatically center in the composition.

. Because you are using square pixel footage (from Flash MX 2004) in a DV composition

using non-square pixels, you need to size the footage file appropriately. Use the fit-to-
comp shortcut (Ctrl+Alt+F or 8+Option+F) to rescale the footage to the size of the
comp. The borders of the footage should now match the borders of the comp.
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Composition Settings

Composition Name: Flash Animation

Basic "\ Advanced

Preset: | NTSC DV, 720 x 480 =R
Width: = 720
.'ﬂ Lock Aspect Ratio to 3:2
Height: = 480
Pixel Aspect Ratio: = D1/DV NTSC (0.9) = Frame Aspect Ratio

2720

Frame Rate: 29.97| Frames per s cond

Resolution:  Full 1% 720450, 1 30 per @bpc frame

Start Timecode:  0;00;00;00  Base 30drop

Duration:  0;00;04;25 0000425 Base 30drop

7 Cancel f 0K A

Figure 14-13: Composition settings for DV-format (for
example, MiniDV, DVCAM) video

. Check the Frame Blending option for the image sequence layer in the Timeline win-

dow. Alternatively, you can select the layer in the Timeline window and choose
Layer > Switches = Frame Blending.

Drag the imported soundtrack file to the Timeline window of the Flash Animation compo-
sition. If you are using a QuickTime Video from the Mac version of Flash MX as your
soundtrack, turn off the video track by clicking the eye icon to the left of the layer name.
Alternatively, you can select the layer in the Timeline window and choose Layer =
Switches => Video. The Timeline window should match the one shown in Figure 14-14.

000 Flash Animation s Timeline

[EF1ash Animation &

0;00;00:00 [l (2= R
[Bo0 & [5]* [ sourcetame 2%~ s BMeD |rFarent Jroos ois 025 03: 0ds ¥
® PO 1 B anim_[0001-0145]1 | & 7 @ [Mone ~] =]
IR IR R B - ounatrack mo v IEC @ [Wore Sl e R D S R R e

] Switches 7 Modes [ IS sl =N

Figure 14-14: The After Effects Timeline window with the two imported
Flash assets

Change the background color of the composition by choosing Composition =
Background Color. For this example, try a legal NTSC white value, with an RGB value
of 235, 235, 235. When you're finished, your composition window should look like
Figure 14-15.
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